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President’s Message

Hello Everyone,

Sign up for the December “Member’s Choice” meeting is
on the web site under “Meetings.” Be sure to sign up.This
is a great opportunity to meet other members, share
your favorite pictures, find people who know the secret
spots, or can explain how a picture was made. The club
will be providing meat choices but we need to people to
bring desserts, salads, and vegetables. There’s no
presentation for the December meeting, just socializing
and looking through everyone’s favorite photos.

November’s meeting will feature a presentation by Carol
Highsmith on her work documenting America for the last
40 years.You can find her work on the Library of
Congress website at loc.gov. Rumor has it that she shoots
a 100-megapixel camera, think about how many disk
drives she must carry around to back up each day’s
shooting.

We're finally getting some cooler weather and some rain,
some places are actually getting some fall color this year if
you go north or east from the DFW area.We had a good
time at the Mid America Flight Museum in Mount
Pleasant. They have quite a few aircraft, all in flying
condition, on display. They’re packed together tightly but if
you're interested in WWII and earlier airplanes it’s a great
place to visit.
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They’re packed together tightly but if you're interested in
WWII and earlier airplanes it’s a great place to visit.

| stopped at the Tyler Rose Museum on the way back and
they still had plenty of flowers in bloom.

WVe still need officer nominations for next year, including a
nominating committee. If you're interested, please contact
one of the officers so we can go into the new year with all
the offices filled.VWe’re not asking for a lot of time or
organization, a few hours per month is really all that is
required to keep the club working. | know that for me the
club helped me find great locations without having to travel
for days. | still do take those longer trips but | get more
practice and opportunities being able to go up to Hagerman
National Wildlife Refuge, that | didn’t know about even
though | lived in the area for twenty years. Take some time to
look through the older newsletters online to see where the
club has had field trips in the past to find your next favorite
spot.

Thank-you
Doug Boone

dougboone5@gmail.com
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Tyler Rose Gardens, Doug Boone

Tyler Rose Gardens, Doug Boone
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Mid-America Flight Museum, Doug Boone
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MEMBERS CHOICE CONTEST

Once again it’s almost time for our Members’
Choice meeting. We will meet at noon in the
Science Resource Center for a potluck for our
December meeting. After lunch we’ll vote to pick
our choice to represent the club for 2023!

Upload up to five of your favorite images to the
folder at MembersChoice (https://1drv.ms/u/s!
Asc1vCEOycmLI7QON4755XdQ52h549?
e=J44e0H) for consideration.

2012 Members Choice Winner: Denise Remfert -
Great Blue Heron on Caddo Lake, east Texas
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CONTEST UPDATE

Anita Oakley (anitacak@outlook.com) has agreed to lead the contest committee for the 2023 Heard
Museum Photo Contest. Jackie Ranney (jackieranney(@aol.com) is handling publicity.

If you have any questions about the contest, please feel free to contact either of us. If you belong to
photography-oriented Facebook groups, other photo clubs, or have photographically inclined friends please let
them know about the contest!

Submissions begin: March 25,2023
Submissions end: April 15,2023

Last day to accept payments: April 17,2023
Judging: Negotiable, but around April 21,2023
Awards Ceremony: May 14,2023

We have some exciting new categories in addition to the ones we had last year:

* People and Nature — Images depicting a person or people interacting with nature. May include people
enjoying nature or the way people affect nature.

* Seen at the Heard — Images captured anywhere outdoors at the Heard Museum, including along the
wildlife trails, in the butterfly exhibit, or at the Dinosaurs Live exhibit.

 Aerial Images — Images captured from a drone, helicopter, or plane. Must be nature-related.


mailto:anitaoak@outlook.com
mailto:anitaoak@outlook.com
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CHANDOR GARDENS FIELD TRIP

October 1, 2022

What a delightful surprise for nature photography after a really tough summer! Driving through the
automatically-opening iron gates precisely at 9:00 a.m., it was obvious that the grounds of Chandor
Gardens had the advantage of their own well plus “city water”. The entire 3.5-acre site was absolutely
gorgeous! Just ask Mary Binford, Doug Boone, Andy and Kim Franklin, Tom Martin, Gabby Pruitt,
Jackie Ranney, Terree Stone, David Valdez and Linda and George Vardas — they were all there!

Chandor Gardens, Jackie Rainey


https://weatherfordtx.gov/170/Chandor-Gardens
https://weatherfordtx.gov/170/Chandor-Gardens
https://weatherfordtx.gov/170/Chandor-Gardens
https://weatherfordtx.gov/170/Chandor-Gardens
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Chandor Gardens in Weatherford was established by the British-born portrait painter Douglas Chandor in
1936. It was originally named “White Shadows” then his wife renamed it after Chandor’s passing. There are
wonderful little waterways, walkways, bridges, ponds, architectural details, mature trees and lush,
meticulously maintained planting areas. We were fortunate to have had excellent weather for enjoying this
treasure. It is well worth the drive for a visit. htips://weatherfordtx.gov/170/Chandor-Gardens

Lunch at the Antebellum Ale House was a delightful stop and perfect after a morning of photography. It
appears the preferred drink for a few of our group was their root beer floats. This is worth another stop should
anyone be in that area!

We hope you will join us on other field trips being planned for the club going forward!

Jackie Ranney
Field Trip Co-Coordinator

Mary Binford

Doug Boone


https://weatherfordtx.gov/449/Location-Directions
https://weatherfordtx.gov/449/Location-Directions
https://weatherfordtx.gov/458/Chandor-History
https://weatherfordtx.gov/458/Chandor-History
https://weatherfordtx.gov/170/Chandor-Gardens
https://weatherfordtx.gov/170/Chandor-Gardens
https://craftbeerweatherfordtx.com/
https://craftbeerweatherfordtx.com/
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Jackie Ranney
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A butterfly alights on Gabby, Terree Stone
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MID AMERICA FLIGHT MUSEUM FIELD TRIP

Heard Nature Photographers Doug Boone, John Deal, Steve Earles, Martha Taylor, David Valdez, and
George Vardas met at the Mid America Flight Museum in Mt. Pleasant, TX Saturday, October 22.
Photography was a challenge in the museum. Lighting was difficult and the aircraft were parked very
close to each other. The museum is a fascinating place, with over 40 vintage aircraft on display, many of
which are operational today. The museum allows visitors to get up close and in some instances, they
allow visitors to climb in the aircraft. The museum is staffed by knowledgeable volunteers who make the
visit more interesting by sharing the history of the aircraft. If you find yourself in the Mount Pleasant area
it is well worth a few hours of your time. Their website is https://midamericaflightmuseum.com. After
spending a few hours at the museum, the group retired to Laura’s Cheesecake & Café for lunch.
Recently featured on The Texas Bucket List, it did not disappoint. Laura’s is famous for cheesecake.

Our next scheduled field trip is a weekend trip Friday November 4 to Sunday November 6 to Beaver’s
Bend State Park located in southeast Oklahoma along the shores of Broken Bow Lake. We are hoping
for some vivid fall colors. Register on the Heard Nature Photographers website.

Steve Earles
Field Trip Coordinator

All photos from the Museum website


http://www.midamericaflightmuseum.com
http://www.midamericaflightmuseum.com
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Meetings

Heard Nature Photographers Meeting Schedule, 2022

Page 13
in person and on Zoom

an e-mail will be sent to members
with the ZOOM link

NEW MEETING TIME:
10:00 AM, Laughlin Hall

DATE SPEAKER TOPIC
November 12, 2022 Carol Highsmith Library of Congress Photography

December 10, 2022

Members Choice

Meetings will be ZOOM and in person,
October and November.

The December meeting will be
Members Choice and Holiday Gathering,
in person.

Beginning in January, all meetings
will be in person.

SNACKS

Refreshment Coordinator, Linda Grigsby
will be out of town.

Terree Stone will setup and bring chips
and snack cakes. Anita Oakley and Mary
Binford are both bringing small
sandwiches.


http://carolhighsmithamerica.com/
http://carolhighsmithamerica.com/
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NOVEMBER SPEAKER

CAROL HIGHSMITH

Carol M. Highsmith with her Phase One camera at
the George W. Bush Ranch in Crawford, Texas

Website:
http://carolhighsmithamerica.com/

About Carol:
http://carolhighsmithamerica.com/me/
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Topic:
DOCUMENTING AMERICA

About Carol:

Carol M. Highsmith has been visually documenting America for more
than forty years. She is donating her life’s work to the Library of
Congress, where it is preserved in the most historic photo collection
on Earth.

Highsmith’s thousands of images from her comprehensive exploration
of the fifty states will be available for free from our nation library for
the ages.

Highsmith has also published and been published in more than 50
books. She recently completed a book on Louisiana for Louisiana
Public Television which is producing a documentary on the Bayou
state and the 256-page coffee table book by Highsmith will be a
companion piece to the 4-hour documentary.

She has also worked with National Geographic, the National Trust,
the Library of Congress and Random House Publishing, Inc. on
various books.

Her speech will be about the importance of documenting America and
following through with an enormous project for years and sticking with
it. The name of the speech will be “Carol Highsmith’s Lifework For the
Ages".

| will be home near the Washington, D.C. area in November having
been on the roads of America for months in 2022.


http://carolhighsmithamerica.com/
http://carolhighsmithamerica.com/
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Carol M. Highsmith portrait while working in Wyoming Big Creek Ranch
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ROB HULL

If you are a Canon user, there is a workshop tailored just for you. Rob Hull, a Lifetime member and former president of
Heard Nature Photographers, is hosting the Canon Advanced User Workshop on November 5 & 6. It’s a hands-on, 2-day
workshop that is laser-focused on Canon DSLR and mirrorless cameras.

Rob will be joined by Bob Malish from Canon. Bob is one of those guys who travels the world supporting professional
photographers assigned to events like the Superbowl, Olympics, and Formula 1 races.

It doesn’t matter if you’re a seasoned professional or an aspiring amateur, you will discover more about your camera than
you ever thought possible.

Take advantage of a $50 discount offered to club members. Just use the discount code CAU-HEARD when you check out.
For more information and to register, visit Rob’s website at www.GreatPhotography.com/canon.

Rob will also be hosting a Camera Flash Workshop on November 12 & 13. Check out his website for details: https://
www.greatphotography.com



http://www.GreatPhotography.com/canon
http://www.GreatPhotography.com/canon
https://www.greatphotography.com
https://www.greatphotography.com
https://www.greatphotography.com
https://www.greatphotography.com
https://www.greatphotography.com
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ROB HULL PHOTOGRAPHY
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ROB HULL PHOTOGRAPHY
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HEARD NATURE PHOTOGRAPHERS
2022 FIELD TRIP SCHEDULE

DATE TIME TRIP/LOCATION ADDRESS ADDITIONAL INFORMATION

711 West Lee Avenue

Weatehrford, TX 76086 To register: please go to the website:
(map) https://
www.heardnaturephotographers.com/

November 4-5-6, Recommend making lodging
Eri/Sat/Sun 2022 Beavers Bend State Park Southeast Oklahoma reservations ASAP.

As of 5/27/2022, Lakeview Lodge
within the park is still under
renovation.

**NATURE PLUS is a designation for a field trip that includes “the hand of man” subject matter, in addition to nature



https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.heardnaturephotographers.com
https://www.heardnaturephotographers.com
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BEAVER’S BEND STATE PARK

NOVEMBER 4-5-6, 2022

FIELD TRIP ANNOUNCEMENT
FRIDAY-SATURDAY-SUNDAY, NOVEMBER 4, 5, 6, 2022

DESTINATION:
Beaver’s Bend State Park
Broken Bow, OK

This is far out, it’s hard to predict the exact change of colors
so we

are taking our best shot! So much will depend upon Mother
Nature!

DATE/TIME:
FRIDAY-SATURDAY-SUNDAY, NOVEMBER 4, 5, 6, 2022
ARRIVE: Ideally Friday afternoon/evening Photography by Jackie Ranney

PLANS:

Still being formulated, but here’s a general idea:

- Saturday morning - sunrise photography (about 7:40 am).
- Continue shooting in the park until lunchtime.

- Saturday lunch - as of September 16, 2022, it is still
undetermined if Foggy’s will re-open by the time our field trip
is happening

- Saturday afternoon - on your own; no “club-organized”
activities.

- Saturday evening - group dinner - location TBD.

- Sunday — departure at participant’s option.

Photography by Nancy Mack


https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
https://www.travelok.com/state-parks/beavers-bend-state-park
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LODGING:
- Beaver’s Bend State Park has cabins (reservations 580/494-6300) or
go to their website. (The website is not showing

much availability; different than calling!) e Lakeview Lodge (inside the
park)— still under renovation as of 3/6/2022.
Projected completion is September 2022 — they are not yet taking
reservations.

- Check VRBO, Airbnb, booking.com and other vacation rental sites for
houses/cabins. Search Hochatown, OK or
Broken Bow, OK.

- https://guestrez.megasyshms.com/TTPRB/beavers-bend-state-park?
a=2.55111145.375172306.1646529802-356434746.1646529801

STATE PARK PARKING PASS:
Using the link provided above, please review the policy about fees and
a parking pass to be inside of this park.

REGISTRATION:
Register on our website

Final details will be sent to registrants a few days before the event.

YOU MUST BE A PAID MEMBER TO PARTICIPATE IN FIELD TRIP EVENTS

Photography by Jackie Ranney

Photography by Nancy Mack
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THE ACCIDENTAL FLOWER PHOTOGRAPHER


http://heardnaturephotographers.com/
http://heardnaturephotographers.com/
https://www.planophotographyclub.com
https://www.planophotographyclub.com
https://www.planophotographyclub.com
https://www.planophotographyclub.com
https://www.dallascameraclub.org
https://www.dallascameraclub.org
https://dallasweavers.org/
https://dallasweavers.org/
https://www.heardnaturephotographers.com/newsletter-archive
https://www.heardnaturephotographers.com/newsletter-archive

my weaving journey


https://avllooms.com/
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https://www.glimakrausa.com/looms
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the kimono weavings



Helena Hernmarck
workshops

| have attended workshops with Helena Hernmarck, one of the most influential tapestry weavers in
Europe and the US. She has developed a special technique for creating photographic images in her

gigantic tapestry murals, which are woven completely on large, manual tapestry looms.


https://www.hernmarck.com/
https://www.hernmarck.com/
https://www.hernmarck.com/beast
https://www.hernmarck.com/beast
https://thealdrich.org/exhibitions/helena-hernmarck-weaving-in-progress
https://thealdrich.org/exhibitions/helena-hernmarck-weaving-in-progress

| have also studied with Cathryn Amidei who creates landscape tapestries on the Digital Norway TC2
computerized Jacquard loom. This loom was created for prototyping and sampling for the textile industry, but
has become an important artist’s tool for creating photorealistic weavings. The process involves selecting an
image, editing it in an industrial Jacquard loom software package - including Photoshop, - transferring that edit
to the loom controller software and weaving the image. Thus the scene that the Renaissance tapestry weaver
took years to finish, is now only limited by the weaver’s output per hour! Needless to say, the cost of the loom is
equivalent to buying a mid-priced car! (My color images below, sampled in B/W above.)

Calla Lilies, Nancy Mack Ranuculus, Nancy Mack


https://www.cathrynamidei.com/
https://www.cathrynamidei.com/
https://www.cathrynamidei.com/portfolio
https://www.cathrynamidei.com/portfolio
https://digitalweaving.no/
https://digitalweaving.no/
https://www.tronrud.no/en/industrialized-products/products/tc2-loom
https://www.tronrud.no/en/industrialized-products/products/tc2-loom

| finally gave up the film camera and the point-and-shoot and invested in a real camera. My daughter-
in-law explained the Exposure Triangle and f-stops and | took a course at Collin College, some online

classes and joined a club.

My son-in-law enjoys cooking (I think he likes shopping at Williams Sonoma even more..) and invested

in the very expensive “The Art of Modernist Cuisine” series. The photos are fabulous. Browsing a

bookstore one day, | discovered “The Photography of Modern Cuisine”. This 13-lb volume - which
accompanies the cook book - introduced me to “focus-stacking” photography. My weaving hobby
went by the wayside. | spent the next few years exploring how to do this with flowers. Flowers from

grocery stores. Flowers from my garden. Flowers from my neighbors’ gardens. Gifts for mom: send

flowers to photograpb!

<
13.5”

A | started by rotating my lens in increments and finally invested in Helicon
Soft - software for capturing individual photos from the nearest to the
furthest focal point and the companion software for merging these into a

final sharp front to back image.

The goal was not photography. | needed a “cartoon” that | could place

behind the warp threads on the loom and ultimately weave into a tapestry.

} And how many of these photographs have | woven??? Not a single one.

| am too busy take photos of flowers. My looms are sadly idle.
16.5”


https://modernistcuisine.com/books/modernist-cuisine/
https://modernistcuisine.com/books/modernist-cuisine/
https://modernistcuisine.com/books/photography-of-modernist-cuisine/
https://modernistcuisine.com/books/photography-of-modernist-cuisine/
https://photographylife.com/focus-stacking-macro-photography
https://photographylife.com/focus-stacking-macro-photography
https://www.heliconsoft.com/
https://www.heliconsoft.com/
https://www.heliconsoft.com/
https://www.heliconsoft.com/
https://rebeccamezoff.com/blog/2010/12/tapestry-cartoons.html
https://rebeccamezoff.com/blog/2010/12/tapestry-cartoons.html

focus stacking

Images were captured indoors in Helicon Remote
- starting at the closest focusing point and finishing at the furthest focusing point.

This resulted in 25 images (five seen above.)

These RAW images were taken into Lightroom and exported to Helicon Focus and processed. They were
saved as .dng files and the final image edited in Lightroom. | took the image into Photoshop to clean up

blemishes on the petals.


https://www.heliconsoft.com/heliconsoft-products/helicon-remote/
https://www.heliconsoft.com/heliconsoft-products/helicon-remote/
https://www.heliconsoft.com/heliconsoft-products/helicon-focus/
https://www.heliconsoft.com/heliconsoft-products/helicon-focus/
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Curving Softly, Nancy Mack
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Here Comes the Sun, Nancy Mack



Iris Images, Nancy Mack
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Iris, Nancy Mack
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Frozen Ranunculus, Nancy Mack
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The Tulips are Excitable, Nancy Mack



Mostly Roses, Nancy Mack
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Rainy Day, Nancy Mack



Alone in the Night, Nancy Mack
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Ghost Dahlia, Nancy Mack



In the Shadows, Nancy Mack Tulips, Nancy Mack
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Morning Glow, Nancy Mack
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Ranunculus Bouquet, Nancy Mack
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Leaning Softly, Nancy Mack
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Procession, Nancy Mack
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Flower Photography References

Kathleen Clemons - macro flower photography
https://www.kathleenclemonsphotography.com/

Anne Belmont - macro flower photography
https://www.annebelmontphotography.com/

Anne Belmont has a series of flower photography
videos on the Out of Chicago YouTube Channel:
https://www.youtube.com/c/OutofChicago/videos

Out of Chicago Blog has some entries on flower
photography: https://www.outofchicago.com/blog/

International Garden Photographer of the Year

Harold Feinstein
Various books of flower portraits

Robert Liewellyn
Flower Portfolios
Books about Flowers, Seeds, Trees

Andrew Zuckerman
Flower

Robert Mapplethorpe
Flowers

Robert Mapplethorpe
Flowers

Harold Davis:

Creative Garden Photography: Making Great Photos
of Flowers, Gardens, Landscapes, and the Beautiful
World Around Us

Creative Close-Ups: Digital Photography Tips &
Techniques

Photographing Flowers: Exploring Macro Worlds

Niall Benvie

flowers

Niall Benvie Photography
Meet Your Neighbors

Joyce Tenneson
Intimacy: The Sensual Essence of Flowers
Flower Portraits: The Life Cycle of Beauty

Barbara Bordnick

Flowers

Searchings: Secret Landscapes of Flowers
Vol. I, II, 11
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https://www.robertllewellyn.com/
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https://www.robertllewellyn.com/BOOKS/Seeing-Flowers/1/caption
https://www.robertllewellyn.com/BOOKS/Seeing-Flowers/1/caption
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PHOTOGRAPHIC SOCIETY
OF AMERICA

https://psa-photo.org/

The Photographic Society of America
(PSA), founded in 1934, is a world-wide
organization providing abundant
resources for photographers, from the
novice to the professional. PSA offers
on-line learning, webinars, study
groups, competitions, mentors and
consultants. Membership is in over 80
countries, 5,000 members, 460 Camera
Clubs and 12 Chapters across the
United States.
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GULF STATES
CAMERA CLUB

http://www.qulf .or

In the Gulf States Camera Club
October Competition,

Alan Daniel received 15t Alternate for his
Nature image “Landing”,

and

Ron Marabito received 15t Alternate for his
Monochrome image “Brown Pelican”.


https://psa-photo.org
https://psa-photo.org
http://www.gulfstatesccc.org
http://www.gulfstatesccc.org
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If you are a new member, or are renewing a long standing
membership, you may want to visit our “About” Page. The Club is
an auxiliary group hosted by the Heard Natural Science Museum
in McKinney, TX. Here you will read the history of the club and
see a map of the in-person (when available) meeting location on
the Heard Natural Science Museum grounds.

The club was established in 1981 and has served the nature
photography enthusiast ever since. We are an affiliate of the

Photographic Society of America and focus our attention on
nature photography.

We have a distinguished list of Honorary Life Members and all
Past Presidents are listed.

The Bylaws and Policies are also available.

Although meetings cannot be in person at this time, the Heard

Natural Science Museum and Wildlife Sanctuary is currently open

and we encourage you to grab your camera and take a winter
walk! Visit their EACEBOOK page for updated activities.

Membership to the Heard is available at different price levels, as

well as activities for all ages.

CLUB WEBSITE

SOCIAL MEDIA LINKS
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Contest VWebsite

Thank You!! Thank you for being a supportive member of the
Heard Nature Photographers Club. We really appreciate having
you as a part of our growing family. Our association is better
because of you.

Membership in the club is only $10 this year. Use the link on this
page to renew your membership.

Remember that, as a member, you can participate in some
awesome field trips when the club once again meets in person.
Our meeting speakers provide incredible insight into photography

and our host, the Heard Natural Science Museum, is an incredible
facility.

Currently, members are able to take advantage of excellent
speakers via ZOOM meetings and the club often meets in
conjunction with area photography clubs while meetings are
canceled.

If you are a first time member, you may want to read about the

club. The Heard Nature Photographers Club is an auxiliary group
of the Heard Natural Science Museum, McKmney, Texas. Click

he w

Membership is $10. per year for 2022 and reverts to $20. per
year for 2023. You will be able to pay by credit card.

Dues can be paid via PayPal directly to
membership@heardnaturephotographers.com

Other options are to send a check made payable to:
Heard Nature Photographers to:

Treasurer, Brian Clark

Heard Nature Photographers

441 Cherry Spring Drive

McKinney, TX 75072
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GREETING CARD DESIGNER

ROB HULL

It’s getting to be that time of year when you want to share your artistry with friends and family. I’'m talking
about creating your own greeting cards, it’s a powerful and unique way to share your work.

Once you understand the process, greeting cards can be designed and printed quickly. But be forewarned, you
need to do a little homework first. Also, remember that we are talking about using your own inkjet printer, not
sending them out to a lab.

First I’ll share with you the steps necessary to create a card from scratch in Photoshop. And then, I'll share with
you some actions that automate the process.

Before you get started
Before you march headlong into Photoshop you need to understand a few key limitations for laying out
greeting cards.

Greeting cards are usually printed on special paper stock. Like standard photo papers, you can purchase
greeting card stock in glossy or matte finishes or even elegant artistic papers. These papers, however, are
scored to accommodate the fold and are cut in unusual dimensions that will result in standard folded
dimensions. For example, if you wanted a 5” x 7” greeting card, the pre-scored stock will be 10” x 7”.

This brings us to our most important limitation. Because greeting card stock is usually cut to non-standard
dimensions, there are few printers that have the capability to print borderless images using these papers.
You'll find that even with a printer that is advertised to print borderless, the feature is limited to specific
standard sizes such as 8” x 10”7, 5” x 7” and 4” x 6”. Because of this you need to allow for a non-printable
margin on all sides of the card.
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The size of this margin depends upon the minimum margin for your specific printer model. To find this look in
the printer reference manual for the section that describes the Printable Area. The sample above is for an
Epson photo printer and you’ll see the minimum margin is 3mm or 0.12”. We'll use this for our sample card.

Lay Out Your Card

Now that you have all the printer specifications and know the size of the greeting card you want, it’s time to
open an image and create a card. In our sample card, we are going to create a 5” x 7” card and prepare it for a
printer that has a minimum margin of 0.12”. The card stock is 10” x 7”.

Open the image that you want to use for the card. It’s a good idea to do a File > Save As... to save the greeting
card using a different file name.

Select the crop tool and crop your image using the following tool options;

e Width: 6.76 inches
e Height: 4.76 inches
e Resolution: 300 ppi (or whatever you use for your printer)

Now we’ll add the unprintable margin by using the Image > Canvas Size... dialog; enter the following options;

Width: 7 inches
Height: 5 inches
Keep the Anchor in the center
Canvas extension color: White
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Now that the front of the card looks good, it’s time to add the portion that will become the back of the
card. Once again, we use the Image > Canvas Size... dialog box but this time we change the anchor point.
Where you move the Anchor point depends upon whether you are creating a portrait style or landscape
style card. In the Landscape Style sample above we move the Anchor point to the bottom. This will create
a fold above the image. (For a Portrait Style card, the Anchor point would be moved to the right.) In the
dialog box use the following options:

e Width: 7 inches

e Height: 10 inches

e Anchor: Move it to the bottom center

e Canvas extension color: White

Once complete, you're ready to print your card. You’ll need to follow your printer’s directions to know how to
load your card stock to ensure that your image is printed on the proper side of the paper. When you are done,
you will have a beautiful greeting card ready for mailing.

Greeting Card Stock

If you're looking for card stock on which to print your images, click on over to the Red River Paper website.
They have a tremendous assortment of greeting card stock, from Glossy and Luster cards to 100% cotton fine
art papers. My personal favorite is their 60lb. Polar Matte and I've basically standardized on the 9" x 6.25"
size. I've printed our family Christmas Card on this stock for over 10 years.

Help Laying Out Cards

If you want a little help laying out cards - and you know how to run actions in Photoshop - you should look at
my Greeting Card Designer actions. It's a set of actions that run on Photoshop and lay out the card for you.
You can find them at www.PlayWithYourPixels.com.



http://www.PlayWithYourPixels.com
http://www.PlayWithYourPixels.com
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card samples
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The Conversation, Nancy Mack



